Optimizing Internet Explorer Browser Settings
For Oracle Apps, Marking Imaging, Peoplesoft CMS and related Applications

Hardware and Operating Systems Requirements

Intel 2.66 GHz or greater Pentium 4 processor
512 MB or greater RAM

Internet Explorer 7.0

Windows XP SP2

l. Introduction

For desktops running MS Windows XP, Internet Explorer must be configured for use with Oracle Applications,
MarkView Imaging, and with Oracle / PeopleSoft Applications. The following are step-by-step procedures to
optimize your browser settings.

Note: These settings are for Internet Explorer, but can be used as a guide line for Firefox users as well. On
Figure 14 of this document is a screenshot addressing tabbed browsing specific to Firefox users.

Note: Oracle Applications requires installation of Sun’s Java Runtime Environment version 1.6.0_xx (current
version is _18). To install the Sun Java JRE, you will need administrator rights. Visit http://java.com to install
the most current version of Java.

Il. Configuring Internet Explorer

1. For Windows XP, launch Internet Explorer
2. Select Tools | Internet Options | General | | Browsing History | Settings

3. Under the heading, “Check for newer versions of stored pages:” select <Every time | visit the
webpage> (see Figure 1)

Internet Explorer Settings Document
Version Number 4.0
Updated September 2009

Page 1 of 22


http://java.com/�

For Oracle Apps, Marking Imaging, Peoplesoft CMS and related Applications

4. Click <OK>
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Temporary Internet Files and History Settings E|

Temporary Internet Files

Internet Explorer stores copies of webpages, images, and media
for Faster wiewing later,

Check for newer versions of stored pages:
(%) Every time I visit the webpane!
{:} Ewery time I start Internet Explorer
() Aukomatically

{:} Mewver

Disk space to use (3 - 1024MB): so0 &
(Recommended: 50 - Z50ME)

Current location;

C\Documents and Settingsidroelofs, BA, 0004 Local

Settingst Temporary Internet Files),

[ Move Folder. . ] [ Wiew ohjecks ] [ Wiew Files

Hiskory

Specify how many days Internet Explarer should save the list
of websites vou have wisited,

e

-

Days to keep pages in hiskory; 20

Ik l [ Cancel

Figure 1

5. Select Tools | Internet Options | Security
6. With the Internet Icon highlighted, select <default level> (see Figure 2)
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Internet Options

izeneral | Security |F‘rivan:y Conkent | Connections || Programs | &dvanced

Select a zone bo wievs or change security settings.

Q@ /0

Local inkranet  Trusted sikes  Restricted
sikes

Internet

Q This zone is for Inkernet websites,
except those lisked in trusted and

restricked zones,

Security level For this zone

Custom
Cuskom setkings.
- To change the settings, click Custom lewvel,
- Touse the recommended settings, click Default level,

[ Cuskam level,. . H Default level ]

[ Reset all zones to default level ]

[ Ok l [ Cancel

Figure 2
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7. With the Local Intranet Icon highlighted, select <default level> (see Figure 3)

Internet Options

meneral | ecurity |P'riva|:y Content | Connections | Programs | &dvanced

Select a zone to view or change security sektings,

@ @ / O

Internet W\ Npl{=al=%¢ Trusted sites  Reskricked
sites

Local intranet
.% This zaone is for all websites that are

found on your intranet,

Security level for this zone

Custom
Cuskom setkings,
- Ta change the setkings, click Cuskarmn level,
- To use the recommended settings, click Default level,

[ Custom level. .. H Default level ]

[ Reset all zones ko default level ]

[ K H Cancel H apply ]

Figure 3
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8. With “Trusted Sites” highlighted, select <Sites>. (see Figure 4)

Trusted sites le

#dd this website ko the zane:

By this zome will use the zone's security setkings.

¥ou can add and remave websites Fram this zone, All websites in

Wehsites:

Require server verification (htkps:) Far all sikes in khis zone

Close

Under the heading “Add this Web Site to the zone”, enter these “trusted” URLSs:
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https://aspen.sdsu.edu
https://banff.sdsu.edu
https://bryce.sdsu.edu
https://cmsweb.cms.sdsu.edu
https://fiji.sdsu.edu
https://sedona.sdsu.edu
https://tahiti.sdsu.edu
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Then press <Add> | <Close> (see Figures 5 and 6)

Trusted sites

3

You can add and remaove websites Fram this zone, All websites in
L 4 this zone will use the zone's security setkings.

Add this wehsite to the zone:

| https:fitahiti. sdsu. edu

[

Websites:

hkkps: ) aspen.sdsu.edu
htkps: [ fbanff sdsu,edu
https: /{brvce. sdsu.edu
htkps: [fcmsweb, sdsu, edu
htkps: [ Ifiji sdsu,edu

| O S [ S e Uy P

%3

b

Require server verification (htkps:) Far all sikes in this zone

Close

Figure 5

Trusted sites

X]

¥oul can add and remove websites From this zone, All websites in
L 4 this zone will use the zone's security settings.

Add this website to the zone;

Websites;

htkps: [faspen,sdsu.edu
htkps: {fbanff . sdsu.edu
htkps: ffbryce,sdsu.edu
https: ffcmsweb, sdsu.edu
hkkps: [ fFifi sdsu0.edu

Lee— Mo .. .

[

W

Require server verification (hkkps:) Far all sikes in this zone

Close

Figure 6
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9. With <Trusted Sites> still highlighted, select <Custom Level> and update the following
“Security Settings”. These settings will apply to all “trusted sites” only:

“Download signed ActiveX controls” set to <enable> (see Figure 7)
“Download unsigned ActiveX controls” set to <enable> (see Figure 7)

a.
b.
c.
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“Initialize and Script ActiveX controls not marked as safe for scripting” set to <enable>

(see Figure 7)

Security Settings

Settings:

@ Download signed Activer controls
) Disable
(¥} Enable
{:} Prompk

@ Download unsigned Activel, controls
) Disable
(%) Enable
{:} Prompk

@ Initialize and script Activex controls not marked as safe
) Disable
(¥} Enable
{:} Prompk

@ Fun Ackivel controls and plug-ins

F T N T SO PP |

£ *

£

Reset custom settings

Resetb ko |Low v|[ Reset

]

Ik ] [ Cancel

Figure 7
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10. In order to do a File=Export from within Oracle Apps, downloads should be set as shown (see
Figure 8)
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a.
b.
C.

“Automatic prompting for file downloads”, set to <enable> (see Figure 8)

“”File Download”, set to <enable> (see Figure 8)
“Font Download”, set to <enable> (see Figure 8)

Security Settings

Settings:

@ Downloads

() Disable
{(¥) Enable
@ File download
() Disable
{(¥) Enable
@ Font download
() Disable
(%) Enable
{:} Prompk
&) Miscellaneous

F N

<

@ Aukamatic prompting For File downloads

#&] Access data sources across domains

|

|3

|1

Reset custom setkings

Reset ta:  |Low

w | [ Reset

]

K l [ Cancel

]

Figure 8
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11. “Use Pop-up Blocker” set to <disable> (see Figure 9) and then select <OK>
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Security Settings

Setkings:

@ Iz Pop-up Blocker
(%) Disable
") Enable
rdaka
() Disable
{(*) Enable
@ Weh sites in less privileged web content zone can navi
() Disable
(") Enable
{(*) Prompt
Scripking

Active scripking
~

[ty I

54

<

| ™

1>

Reset custom setkings

Reset to:  |Low v| [ Reset ]

(0] 4 l [ Cancel

]

Figure 9
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12. With the “Privacy” tab highlighted, check <Turn on Pop-up Blocker> (see Figure 10)

Internet Options EIE|

General | Security | PYivacy | Conkent | Conmections | Programs | &dvanced

Settings

Select a setting for the Internet zone.

i

Medium

- Blocks third-party cookies that do not have a compack
privacy policy

- Blocks third-party cookies that save information that can
.| be used ko cantact you without your explicit consent

- Restricks firsk-party cookies that save information that
can be used to contact vou without wour implicit consent

[ Sites ] [ Import ][ Advanced ]

Pop-up Blocker

§ || Prevent most pop-up windows from Settings

appearing.

Turn on Pop-up Blocker

Ik, ] [ Cancel

Figure 10

Please Note: Internet Explorer Plug-ins such as Yahoo- and Google-Search, will install Pop-up blockers of
their own — components of these customized, search toolbars. BFA Policy discourages the use of any IE Plug-
In or downloadable application. However, if you feel the need to use them anyway, be sure to disable any Pop-
up blocking features. Otherwise, Oracle Apps and MarkView imaging will not function properly.
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Optimizing Internet Explorer Browser Settings

13. With the “Advanced” tab highlighted, update the following settings:
Under “Browsing”, uncheck <Reuse windows for launching shortcuts (When tabbed

Internet Explorer Settings Document
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a.

browsing is off)> (see Figure 11)

Internet Options

General | Security | Privacy | Content | Conneckions || Programs Advanced

Settings

Enable third-party browser extensions®* .
Enable visual skyles on butkons and conkrols in webpages
[] Enable websites to use the search pane®
| -Ferceaffsoreen compositing even Onder
Matify when downloads complete
[] Reuse windows For launching shortcuts (when tabbed bro
Showe friendly HTTP error messages
[=] Underline Trkz
® always
O Hower
() Mever
[] use inline AutaComplate
[] use most recent order when switching tabs with Cerl+Tab
[v] Use Passive FTP (for firewall and DSL moderm compatibilicy
< >

*Takes effect after you restark Internet Explorer

Restore advanced setkings ]

‘fou should only use this if your browser is in an unusable skake,

Reset Internet Explorer settings

Deletes all kemporary Files, disables browser
add-ons, and resets all the changed settings.

Ik l [ Cancel

Figure 11
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b. Under “Security”
1. Uncheck <Do not saved encrypted pages to disk> (see Figure 12)

2. Check <Empty Temporary Internet Files folder when browser is closed>
(see Figure 12)

Internet Options gl

General || Security || Privacy || Content || Connections || Programs Advanced

Settings

% Security
Allow ackive content from C0s ko run on My Computer®

[] allow active conkent to rum in files on My Computer®
[] allow software to run or install even i the signature is inv.
Check For publisher's certificate revocation
[] Check For server certificate revocation™
ar signakures on downloaded progra
[] Do not save encrypted pages to disk,
Empky Temparary Internet Files folder when browser is cle
nable Inkeqgrated Windows Authentication™®
Enable native XMLHTTP support
(g Phishing Filter

() Disable Phishing Filker

) Turn off automatic website checking

b
*

<

*Takes effect after yvou restart Internet Explorer

Restore advanced setkings ]

Reset Inkernet Explorer settings

Celetes all termparary files, disables browser

add-ons, and resets all the changed settings,

‘fou should only use this iF your browser is in an unusable state.

Ik l [ Cancel

Figure 12
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14 Using Tabbed Browsing with Oracle Application
Internet Options > General > Tabs > Settings
When a pop-up is encountered: Check “Always open pop-ups in a new window” (see Figure 13)

Tabbed Browsing Settings §|

Enable Tabbed Browsing {requires restarting Internet Explorer)

Warn me when closing mulkiple tabs

Always swikch to new tabs when they are created

Enable Quick Tabs (requires restarting Internet Explorer)

[ ]open only the first home page when Internet Explorer starts
Cpen new tabs nesxt to the current: tab

Cpen home page for new tabs inskead of a blank page

W'hen a pop-up is encountered:

Cpen links From other programs in:
() & news window
() 8 new tabin the current window

{(*)The current tab or window:

[ Restore defaulks ] [ Ok l [ Cancel

Figure 13

15 Select <OK>
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Note: If using Firefox 2.x for Oracle Applications, the Tabs page should be set as follows:

Internet Options (menu) > Tools > Options > Tabs (tab)
New pages should be opened in: a new tab (see Figure 14)

Options [‘S__<|
L a—n| ] [ — | %
LT - 0 l l w | B2y b
Main Tabs Conkent Feeds  Privacy  Security  Advanced

Mew pages should be opened in:

I" LAl

Warn me when closing multiple tabs

Warn me when opening mulkiple tabs might slow down Firefox
Always show the tab bar
[+]: when I open a link in a new tab, swikch ko it immediately:

| ok

l [ Cancel ] [

Help

Figure 14

16 Select <OK>

Internet Explorer Settings Document
Version Number 4.0
Updated September 2009

Page 14 of 22



Optimizing Internet Explorer Browser Settings
For Oracle Apps, Marking Imaging, Peoplesoft CMS and related Applications

I11. Define a new File Type (.tsv) for exporting to Excel

1. Navigate to My Computer>Tools>Folder Options>File Types (see Figure 15)

Falder Options

General | Wiew | File Types | Offline Files

Reqistered file hypes:

Extenzions | File Types

U (MOME]  AudioCD

e [MOME]  Drive

(2} NOME]  DWD Video

I3 [MOME]  File Folder

[C3){MOME]  Folder

@ [MOME] Help and Suppart Center protocol

/ﬂhl (RICIKICT Lbmrimm b O lemurbma b

[

(£

e Delete

Dretailz for SudioCD file wpe

Openz with: Change...

To change zettings that affect all ‘AudioCD' files, click Advanced.

ak. H Cancel ] Apply

Figure 15

2. Select New>Create New > For File Extension, enter TSV (see Figure 16)

Create Mew Extension

Eile Extension: 754

[ ak. ][ Cancel ]

Figure 16
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3. Click on "Advanced" and for "Associated File Type, find "Microsoft Excel Worksheet" (see Figure

17)

Create Mew Extension

File Extenzion:

Agzzociated File Type: | Microsoft Excel Workzheet w |

[ ak. ][ Cancel ]

Figure 17

4. Click OK. You should then see the following screen (see Figure 18)
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Falder Options

General | Wiew | File Types | Offline Files

Reqistered file hypes:

Extenzions | File Types

BTy Microzoft Excel Warkzheet
(2} NOME)  AudiaCD

< [NOME]  Drive

(2} NOME]  DWD Video

[C3)(MOME)  File Falder

[3)(NOME)  Falder

|wh (RICIKICT el —nd Cimmmr

(013

w

F T mimbmr ek

[ Mew |[ Delete ]

Dretailz for 'TSYW extension

Opens with: @ Microgoft Office Excel

Files with extenszion ‘TS are of twpe "Microsoft Excel Worksheet',
To change zettings that affect all 'Microzoft Excel Worksheet' files,

click Advanced.

Figure 18
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5. Click on the Advanced button (see Figure 19)

Edit File Type

sy
| WMicrosafk Excel Warksheet | [Change Icon... ]
Ackions:
Mewy, ..
Edit...
Eemove
Set Default
Confirm open after download
[ always show extension
Browse in same window
(0.4 l [ Cancel

Figure 19

Make sure the "Confirm open after download" is checked and then click "OK"
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IV. Set Excel Office 2007 settings for exporting to Excel

1. Open MS Excel Office 2007 and click on the Microsoft Office button (see Figure 20)

() AN Y Bookl [Compatibility Mode] - Microsoft Ex... g i T
- /Insert | Page Layc | Formulas | Data | Review | View | Develope | Acrobat | @ - = X
- | Calibri i1 - o, A = |z - &7~

Past F |B i T.”A‘ A‘| 4 |Humb Styl Cell [ET %T

dste e I o S DI T o | | = Humber e5 215

e e o e
Clipboard T Fant Wl Algnment 5| L |l eating
AL -Q fe | ¥

Blan e [ c [ o [ e [ ¢ [ o[ u |§
1
R | |
e E
3] 1
E:
3|
|
iz
8 |
|
10

4

4+ b M| Sheetl - Sheetz - Sheet3 . +J I

Ready | 3 |

Figure 20
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2. Click on “Excel Options” in the bottom of the drop-down menu and click on the “Trust Center”
option (see Figure 21)

Excel Options

|—' Popular .-| — . . 2
E Change the most popular options in Excel.
Formulas
Proofing Top options for working with Excel
Save Show Mini Toolbar on selection ti
Enable Live Preview G
Advanced
Show Developer tab in the Ribbon '
Customize Abhways use ClearType
AddIns LColor scheme:
(I’ Trust Center ScreenTip style: | Show feature descriptions in ScreenTips w |
N
BesouTie: Create lists for use in sorts and fill sequences: | Edit Custom Lists... ]
When creating new workbooks
Use this font: |Bod].-' Fant b |
Font size:
Default view for new sheets: | Mormal View b |
Include this many sheets: 3 £ hl
< | 2
[ K l [ Cancel
Figure 21
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3. Click on “Trust Center Settings” (see Figure 22)

Excel Options

]

Popular
. @ Help keep your documents safe and your computer secure and healthy.
Formulas
Proofing Protecting your privacy
Save Microsoft cares about your privacy. For more information about how Microsoft Office
Excel helps to protect your privacy, please see the privacy statements,
Advanced

Show the Microsoft Office Excel privacy statement
Customize Microsoft Office Online privacy statement
Customer Experience Improvement Program

Add-Ins

|: Trust Center :| Security & more

BesouUrces Learn more about protecting your privacy and security from Microsoft Office Online,

Microsoft Windows Security Center
Microsoft Trustworthy Computing

Microsoft Office Excel Trust Center

The Trust Center contains security and privacy settings, These
settings help keep your computer secure, We recommend
that you do not change these settings.

Trust Center Settings... ]

|
W

Ok ][ Cancel ]

Figure 22
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4. Click on “Macro Settings” (see Figure 23). Check “Disable all macros with naotification” and “Trust
access to the VBA project object model”

Trust Center E

Trusted Publishers
Macro Settings
Trusted Locations ) ) .
Far macros in documents not in a trusted location:
Add-ins {:} Disabl ithout notification
) . "E} Disable all macros with notification
| bchre e —
i N {:} Disable all macros except digitally signed macros
< |-' Macro Settings ';| ) Enable all macros [not recommended: potentially dangerous
a L code can runj
T EEeTTEeeBa— |
External Content loper Macro Setlings
Privacy Options Trust access to the VBA project object model
[ ]9 l [ Cancel
Figure 23

5. Click OK to save
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